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Author’s Notes 
 
For starters, don’t let the size of this document scare you.  The first half of the document is the 
Installation, which YES is of twenty seven (27) products, but most take less than a minute and the bulk 
of the material is screenshots telling you to take the default or “Click Next”.  Two installations take a 
little longer, one just over a minute and the other almost 5 minutes.  Thus, the first half of this 
document should be quick and easy, taking less than an hour to fully complete.   
 
There is one minor issue related to the Java installation to be aware of.  The Java (x86) installation, once 
completed, tried to go to validate and upgrade to a newer version.  Alone this is not a problem, but the 
Java (x64) version, does not do this verification nor upgrade automatically, leaving you at the end with 
Java versions that are out of sync (not a proper configuration).  The recommendation is to ignore the 
Verify and Upgrade during installation of all of the products, this keeps both Java version at the same 
(7u55) version and then later if you wish manually upgrade both version of Java. 
 
The Database Creation section has a lot of material but much of it is redundant.  If at all possible use the  
MS SQL Method 1 – Attach Starter Database to attach the “Starter Database”, this method has always 
worked for us and seems to not have any issues.  MS SQL Method 2 – Create Starter Database produces 
Warning messages each time, which to date don’t seem to be a problem, but it may be a reason for 
concern later on.  The funny thing is, when using the identical MS SQL Method 2 - Creating TRAVEL, 
TRAVEL_E, ORDERS, and ORDERS_E Databases there were no Warning messages. 
 
Licensing of Datamaker is pretty simple and straight forward.  It takes a day to get the License Key back, 
so go to the Generate the Candidate Key section just as soon as you finish the Connecting to Test Data 
Repository section.  Then while you are waiting for the License key, go ahead and create the TRAVEL, 
TRAVEL_E, ORDERS, and ORDERS_E databases, which you will need once you complete the Applying the 
License Key section.  This is because Datamaker needs databases to connect to before everything can be 
accessed and configured.  Licensing of the other products (Agile Designer, Fast Data Masker, and Javelin) 
is done differently using a product called Code Meter.  We’ll document these steps shortly. 
 
The Configuration section is still a little confusing and needs to be validated.  But we think we have 
covered all of the material and steps that you need to get Datamaker fully operational. 
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Introduction 
 
Grid-Tools – is a suite of the world’s most powerful synthetic test data generation products that provide 
market-leading software solutions for provisioning the right data, to the right place, at the right time so 
that it can be used for rigorous testing.  
 
The following is a step-by-step Best Practice Guide for installing, creating, licensing, and configuring the 
Grid-Tools suite of products using the GTServer Setup Wizard.  In general, there are four major steps 
required to make the product operational: 
 

A. Installation 
B. Database Creation 
C. Licensing 
D. Configuration 

 
Installation – using the GTServer Setup Wizard this process is greatly simplified, however be prepared 
because it installs the following products in sequence automatically: 
 

1. .NET Framework 4.5 
2. Silverlight 5 x64 
3. Java SE Runtime Environment 7u55 x86 
4. Java SE Runtime Environment 7u55 x64 
5. Visual C++ 2010 SP1 x64 (MFC Security Update) 
6. Visual C++ 2010 SP1 x86 (MFC Security Update) 
7. Visual C++ Redistributable for Visual Studio 2012 x86 
8. Visual C++ Redistributable for Visual Studio 2012 x64 
9. SQL Server Native client 2008R2 x64 
10. CodeMeter Runtime Kit x64 
11. Adobe Reader XI 
12. ODP4.NET Deployer 
13. GTRemotePublish 
14. GT Group Job Executor 
15. GT HP ALM Service 
16. GT ALM Batch 
17. GTDatamaker 
18. AgileDesigner 
19. TestDataVisualizer 
20. GT – Test Data On Demand 
21. GTSDM 
22. FastDataMasker 
23. GTPortusJobProcessor 
24. Javelin 
25. GTEDI 
26. GTServer  

 
Most of the installations take less than a minute and require very little user interaction with the 
exception of clicking “Next” and taking the default entry.  This section is mostly screenshots with a few 
notations that point out anomalies or issues that you might encounter. 
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Database Creation – is somewhat simple because you can download the Datamaker Installation Kit 
(datamaker_installation_kit##.zip) which has prebuilt “Starter Databases” for Oracle and MS SQL.  With 
these databases you simply copy them to the Database Server and then “Attach” them as if they were 
an existing database. 
 
The Datamaker Installation Kit also contains the files to create the “Starter Database”.  Using this 
method the database is manually created, and then using the files provide in the Kit, commands are 
executed that create the Database Schemas and import Data.   
 
Also included in the Datamaker Installation Kit are folders and file for creating various other databases 
that are used for training, and could be used for demonstration and POC purposes.  
 
Licensing – is a required for several of the Grid-Tools products: 

 Agile Designer 

 GT Fast Data Masker 

 Datamaker 

 GT Subset 

 Quick Design 

 Portus Control Centre 

 Mainframe (DBOS by Syncosrt) 

 Javelin 
 
In some cases you will need to generate a request which is linked to the computer where you have 
installed Grid-Tools.  In other cases you will need to request a license through Support. 
 
Configuration – of the product consists of telling the various Grid-Tools applications where the database 
and other applications are and how to access them.  There are two main Services which must be 
configured so that they will run: 

 GridToolsRemotePublish 

 GridToolsTDoDService 
 
Additionally, after you are able to fully access Datamaker you will want to create a REP.XML file to 
simplify the login process. 
 
Download 
 
To install the Grid-Tools suite of products download the latest version of setup_GTServer.exe at the 
following link: 

 www.grid-tools-downloads.com/release/GTServer/Latest/ (opens a directory listing) 
 
To create the product database, training databases, and other additional material download the latest 
version of datamaker_installation_kit.zip at the following link: 

 http://grid-tools-downloads.com/release/datamaker_installation_kit31.zip 
 
Document Notes 
 
At the time this document was produced (August 2015) the latest versions of both download files were: 

 setup_GTServer_1.0.64 

 datamaker_installation_kit31.zip 
 
 

http://www.grid-tools-downloads.com/release/GTServer/Latest/
http://grid-tools-downloads.com/release/datamaker_installation_kit31.zip
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Installation 
 
The best way to install the Grid-Tools suite of products is to download the latest version of the GTServer 
Setup Wizard (setup_GTServer.exe).  The Download section of this document has the link for this 
download.  
 
The GTServer Setup Wizard walks through each installation sequentially.  The following is a step-by-step 
guide for using the GTServer Setup Wizard. 
 
GTServer Setup – Prerequisites Wizard 
 

1. Right click the setup_GTServer executable and select Run as Administrator 
 

 
 

2. Click Next 
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The following are the Prerequisites and Applications that will be installed.  In some cases, the GTServer 
Setup Wizard may detect a previous version that has already been installed.  If so, it will check to see if 
the previous installation meets the prerequisite needs and then uncheck the box automatically saying 
the previous version is acceptable. 
 
In most cases, all of the boxes will be checked.  If you do not want to install a particular package simply 
uncheck that application and the installation will be skipped.  Otherwise, each installation will follow in 
sequence (one after the other) walking through the installation of that particular application. 
 
This window of the GTServer Setup Wizard will stay open as each individual product is installed, so if at 
any time you wish to check on the progress of all of the installation simple refer to this window.  

 

 
 

 
3. Verify that all of the applications you wish to install are checked 
4. Click Next 
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The GTServer Setup Wizard will extract all of the applications that it is about to install to the C:\Grid-
Tools\Installers folder and start the installation of the first application. 
 

 
 
Once the installation have completed and the GTServer Setup Wizard is finished this folder will not be 
deleted and if needed these executables can be used again if needed. 
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.NET Framework 4.5 
 

 
 

5. Check the box indicating that I have read and accept the license terms 
6. Click Install 

 This installation will take around 2 minutes 
 

 
 

7. When this screen appears, click Finish to proceed to the next installation 
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Silverlight 5 x64 
 

 
 

8. Click Install now 

  This installation takes less than a minute 
 

 
 

9. (Optional) Verify that the Enable Microsoft Update box is checked or uncheck 
10. Click Next >  

 

 
 
11. Click Close to proceed to the next installation  
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Java SE Runtime Environment 7u55 x86 
 

 
 
12. (Optional) Check the Change destination folder to change the installation location 
13. Click Install > 

 

 
 
14. Click Close and proceed to the Java x64 installation 
15. Close window(s) where Java (x86) is trying to verify and update, do not do that at this time. 

 
Best Practice: Both the Java x86 and Java x64 version should be in sync (same version number).  If you 

run the Java Verify at this time the Java (x86) will update to the newer version.  
However, at the end of the Java (x64) installation this does not happen, leaving you with 
different versions.  Since the Grid-Tools products will run on this version don’t verify and 
update at this time and then later if you wish manually update both versions.    
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Java SE Runtime Environment 7u55 x64 
 

 
 
16. Click Install > 

 
 
17. Click Close to proceed to the next installation 
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Visual C++ 2010 SP1 x64 (MFC Security Update) 
 

 
 
18. Check the box indicating that I have read and accept the license terms 
19. (Optional) Check the Yes, send information about setup experience to Microsoft Corporation 
20. Click Install 

 

 
 
21. Click Finish to proceed to the next installation 



14 

Visual C++ 2010 SP1 x86 (MFC Security Update) 
 

 
 
22. Check the box indicating that I have read and accept the license terms 
23. Click Install 

 

 
 
24. Click Finish to proceed to the next installation 
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Visual C++ Redistributable for Visual Studio 2012 x86 
 

 
 
25. Check the box indicating that I agree to the license terms and conditions 
26. Click Install 

 

 
 
27. Click Close to proceed to the next installation 
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Visual C++ Redistributable for Visual Studio 2012 x64 
 

 
 
28. Check the box indicating that I agree to the license terms and conditions 
29. Click Install 

 

 
 
30. Click Close to proceed to the next installation 
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SQL Server Native client 2008R2 x64 
 

 
 
31. Click Next > 

 

 
 
32. Click I accept the terms in the license agreement 
33. Click Next > 
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34. Verify or enter the Name and Company information if needed 
35. Click Next > 

 

 
 
36. Verify that Client Components will be installed 
37. Click Next > 
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38. Click Install 

 

 
 
39. Click Finish to proceed to the next installation 
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CodeMeter Runtime Kit x64 
 

 
 
40. Verify this screen appears.  This product automatically installs. 
41. Before proceeding to the next installation go to the original GTServer Setup Wizard window. 

 

 
 
42. Confirm that the CodeMeter Runtime Kit x64 has a Status of Installed 
43. Go back to the next product installation (Adobe Reader XI) 
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Adobe Reader XI 
 
A Preparing Installation window should popped up automatically and extracted the installation files. 
 

 
 
44. Verify or select Change Destination Folder if needed 
45. Click Next > 

 

 
 
46. Select an Update option or Verify Install updates automatically (recommended) is selected 
47. Click Install > 
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48. Click Finish to proceed to the next installation 
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ODP4.NET Deployer 
 

 
 
49. Click Next > 

 

 
 
50. Verify or Browse to change the Folder location 
51. Click Next > 
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52. Click Install 

 

 
 

This window will appear, as it says Do Not Close This Window, it will close automatically 
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53. Click Finish to proceed to the next installation 
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GTRemotePublish 
 

 
 
54. Click Next > 

 

 
 
55. Verify or Browse to change the Folder location 
56. Click Next > 
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57. Click Install 

 

 
 
58. Click Finish to proceed to the next installation 
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GT Group Job Executor 
 

 
 
59. Click Next > 

 

 
 
60. Verify or Browse to change the Folder location 
61. Click Next > 
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62. Click Install 

 

 
 
63. Click Finish to proceed to the next installation 
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GT HP ALM Service 
 

 
 
64. Click Next > 

 

 
 
65. Verify or Browse to change the Folder location 
66. Click Next > 
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67. Click Install 

 

 
 
68. Click Finish to proceed to the next installation 
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GT ALM Batch 
 

 
 
69. Click Next > 

 

 
 
70. Verify or Browse to change the Folder location 
71. Click Next > 
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72. Click Install 

 

 
 
73. Click Finish to proceed to the next installation 
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GTDatamaker 
 

 
 
74. Click Next > 

 

 
 
75. Select I accept the terms in the License Agreement 
76. Click Next > 
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77. Features tab: Verify all 5 default features are checked 
78. Installation Folder tab: (Optional) Change the installation location if needed 
79. Click Next > 

 

 
 
80. Click Install 
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81. Since this is a continuous install Do Not check Launch GTDatamaker 
82. Click Finish to proceed to the next installation 
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AgileDesigner 
 

 
 
83. Click Next > 

 

 
 
84. Select I accept the terms in the License Agreement 
85. Click Next > 
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86. Features tab: Verify that Agile Designer is checked 
87. Installation Folder tab: (Optional) Change the installation location if needed 
88. Click Next > 

 

 
 
89. Click Install 
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90. Since this is a continuous install Do Not check Launch AgileDesigner 
91. Click Finish to proceed to the next installation 
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TestDataVisualizer 
 

 
 
92. Click Next > 

 

 
 
93. Verify or Browse to change the Folder location 
94. Click Next > 
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95. Click Install 

 

 
 
96. Click Finish to proceed to the next installation 
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GT – Test Data On Demand 
 

 
 
97. Click Next > 

 

 
 
98. Verify or Browse to change the Folder location 
99. Click Next > 

 



43 

 
 
100. Click Install 

 Note: This screen seems to freeze, be patient, the installation takes 3 – 4 minutes 
 

 
 
101. Click Finish to proceed to the next installation 
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GTSDM 
 

 
 
102. Click Next > 
 

 
 
103. Select I accept the terms in the License Agreement 
104. Click Next > 
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105. Verify or Browse to change the Folder location 
106. Click Next > 
 

 
 
107. Click Install 
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108. Since this is a continuous install Do Not check Launch GTSDM 
109. Click Finish to proceed to the next installation 
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FastDataMasker 
 

 
 
110. Click Next > 
 

 
 
111. Select I accept the terms in the License Agreement 
112. Click Next > 
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113. Verify or Browse to change the Folder location 
114. Click Next > 
 

 
 
115. Click Install 
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116. Click Finish to proceed to the next installation 
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GTPortusJobProcessor 
 

 
 
117. Click Next > 
 

 
 
118. Verify or Browse to change the Folder location 
119. Click Next > 
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120. Click Install 
 

 
 
121. Click Finish to proceed to the next installation 
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Javelin 
 

 
 

122.  Click Next > 
 

 
 
123. Verify or Browse to change the Folder location 
124. Click Next > 
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125. Click Install 
 

 
 

126. Since this is a continuous install Do Not check Launch Javelin 
127. Click Finish to proceed to the next installation 
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GTEDI 
 

 
 
128. Click Next > 
 

 
 
129. Select I accept the terms in the License Agreement 
130. Click Next > 
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131. Verify or Browse to change the Folder location 
132. Click Next > 
 

 
 
133. Click Install 
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134. Click Finish to proceed to the GTServer Installation 
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GTServer  
 

 
 
135. Click Next > 
 

 
 
136. Verify or Browse to change the Folder location 
137. Click Next > 
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138. Click Install 

 Note: This screen appears to freeze, but finishes in about a minute 
 

 
 
139. Click Finish 
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Verifying the GTServer Setup Installations 
 
Once the GTServer Setup Wizard has finished the following icons should appear on the computer’s 
Desktop 
 

 
 

140. Confirm that these Icons (Products) have been installed 
 
The installation of the Grid-Tools suite of products is not complete. 
 



60 

Database Creation 
 
Prerequisite – Install Database Server 
 
The “Starter Database” is used by DataMaker and the other Grid-Tools products as an initial Repository. 
This database can be either Oracle or Microsoft SQL.  Because the Datamaker Installation Kit contains 
the schema and data to build the tables, the only prerequisite is to install one of these database servers. 
 
Datamaker Installation Kit 
 
Once the Grid-Tools suite of products is installed, a “Starter Database” needs to be created for the 
products to use as a Repository.  To assist in this effort Grid-Tools has created a Datamaker Installation 
Kit (datamaker_installation_kit##.zip). This Kit is used to create the “Starter Database”, training 
databases, and has other useful material.  The Download section of this document has the link for this 
download.  
 
Once you have downloaded the Datamaker Installation Kit, extract the compressed (ZIP) file.  It will 
create the following directory structure. 
 

 
 
Of key interest are the following two folders which will be used to create the Databases: 
 

 Install_Repository    Used for Oracle  

 Install_Repository_SQLServer  Used for Microsoft SQL Server 
 
The following are the step-by-step instructions for creating the Datamaker “Starter Database” using the 
Datamaker Installation Kit files. 
 
Note: At this time MS SQL Server has been documented, Oracle steps will be completed soon, but a 

README is provided in the Install_Repository folder if needed. 
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MS SQL Server 
 
Before proceeding this document assumes the following: 
 

 Microsoft SQL Server is installed 

 Microsoft SQL Server Management Studio is installed 

 The User ID being used has permissions to create databases, tables, views, functions, 
procedures, indexes, primary keys, foreign keys, and constraints 

 
There are two methods for creating the “Starter Database”.  The first simply attaches an existing 
prebuilt database.  The second has you create a database and then import schemas and data using 
standard utilities. 
 
MS SQL Method 1 – Attach Starter Database 
 

1. Open Windows Explorer and go to the extracted Datamaker Installation Kit folders 
2. Go to the Install_Repository_SQLServer folder and sort the files by Size 

 

 
 

3. Select the gtrep.mdf file, which should be the largest 
4. Copy this file 
5. Go to the location where the MS SQL Server database file systems are located, usually: 

 
C:\Program Files\Microsoft SQL Server\MSSQL10_50.MSSQLSERVER\MSSQL\DATA 

 

 
 

6. Paste the gtrep.mdf file in this folder 
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7. Open the Microsoft SQL Server Management Studio 
 

 
 

8. Right click Databases and select Attach 
 

 
 

9. Click Add under the Databases to attach window 
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10. Go to the location where you pasted the gtrep.mdf file 
11. Select the file and confirm the File Name field reads “gtrep.mdf” 
12. Click OK 

 

 
 

13. Highlight the gtrep31_starter_log, which should have a message of “Not Found” 
14. Click Remove 
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15. Confirm the gtrep31_starter database is now attached 
 

 
 
Final Note: The removal of the log file eliminates error messages and other issues when attaching 

the database.  Once the database is connected and in use a new log file will be created 
as can be seen above. 

 
The README File indicates that if for some reason you are having trouble attaching the MDF file from 
the MS SQL Server database file systems (DATA Folder) that you should move the MDF file to the Backup 
Folder and try to attach from there. 
 

C:\Program Files\Microsoft SQL Server\MSSQL11.SQLEXPRESS64BIT\MSSQL\Backup 
 
The assumption here is that there might be folder and file permission issues. 
 
Personal Note: 
 
The MS SQL Method 1 – Attach Starter Database method has always worked successfully for me but we 
went ahead and validated the MS SQL Method 2 – Create Starter Database because as you will see this 
method is used when creating the training databases Travel and Travel_E. 
 
If you were successful attaching the prebuilt database then for training or POC purposes you may want 
to proceed to the MS SQL Method 2 – Create Travel and Travel_E Databases section and add those 
databases. 
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MS SQL Method 2 – Create Starter Database 
 
The following method will have you manually create the database, run a SQL Query to add the Schema 
to the database, and then execute a batch file from a Command Prompt that will load the Data into the 
database. 
 
Create the GTREP Database 
 

1. Open the Microsoft SQL Server Management Studio 
 

 
 

2. Right click Databases and select New Database 
 

 
 

3. For the Database Name enter GTREP 
4. For the database file in the PRIMARY Filegroup make the following changes: 

a. Set the Initial Size to 488 MB  
b. Verify that the Autogrowth is set to “By 1 MB, unrestricted growth” 

5. For the second entry (GTREP_log) make the following changes: 
a. Set the Initial Size to 1788 MB 
b. Change the Autogrowth to “By 100 percent, unrestricted growth” 

6. Click OK 
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7. Confirm that the GTREP database was created 
8. Expand the GTREP database 

 

 
 

9. Expand the GTREP database Tables 
10. Confirm that only the System Tables exist 
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Add the Schema to the GTREP Database 
 

11. Go to File > Open > File in the Microsoft SQL Server Management Studio 
 

 
 

12. Go to the Datamaker Installation Kit folder Install_Repository_SQLServer 
13. Select GTREP_SCHEMA.sql 
14. Click Open 

 

 
 

15. Verify that the SQL Query loaded 
16. Important – as shown in the picture change the database from master to GTREP 

 

 
 

17. To test the SQL Query, click Parse (blue check above) 
18. Verify that in the Results “Command(s) completed successfully” appears 
19. Verify that below the Results window a green check followed by “Query executed successfully” 

appears 
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20. To execute the SQL Query, click Execute (red exclamation above) 
21. Verify that below the Results window a green check followed by “Query executed successfully” 

appears again. 
 

Potential Issue: The SQL Query executed successfully but these Warning Messages appeared 
 

 
 
At this time, these Warning Messages appear to have no impact. 
 

22. Highlight the GTREP database and Click F5 to Refresh the Object Explorer 
23. Expand the GTREP database 

 

 
 

24. Expand the GTREP Tables 
25. Verify that numerous tables (Schema) are now in the GTREP database 
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26. Right click dbo.gtrep_auth_control  
27. From the menu execute Select Top 1000 Rows 
28. Verify that the Results are empty 

 
Add the Data to the GTREP Database 
 

29. Open a Command Prompt  
 

 
 

30. Navigate to the Datamaker Installation Kit folder Install_Repository_SQLServer 
 
In this folder there is a batch file GTREP_IMPORT.bat that needs to be executed using specific 
parameters.  The parameters or information needed is as follows: 
 

 Username – usually “sa” or an equivalent user with equal rights to the “target database”  

 Password – password for this user 

 Server – Server Name to the SQL Server machine  

 Target Database – in this case (since we manually created the database) it is “GTREP” 
 
The command that will be entered will look something like this: 
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GTREP_IMPORT username password server GTREP > gtrep_import_log.txt 2> gtrep_import_errors.txt 
 
Once the command is executed three (3) files will be created: 
 

 import_report.txt – this file will open once the command has executed.  Check this file for 
IMPORT errors.  Once you close this file the command will finish. 

 gtrep_import_log.txt – located in the Install_Repository_SQLServer folder.  Check this file for 
“errors” to make sure no commands failed 

 gtrep_import_errors.txt – located in the Install_Repository_SQLServer folder.  It should be 
empty and will only have information if there are DOS command errors. 

 
31. Execute the GTREP_IMPORT command using the correct parameters for your environment 

 

 
 

32. Verify that the Command Prompt stops with “IMPORT Complete” but is still waiting 
33. Verify that the import_report.txt file has opened automatically in Notepad 

 

 
 

34. Check the import_report.txt file for errors 
a. Do a Find looking for the word “errors” 

35. Close the import_report.txt file and verify that the command completes, going back to a prompt 
36. Close the Command Prompt window 
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37. Go to the Datamaker Installation Kit folder Install_Repository_SQLServer 
38. Open the gtrep_import_log.txt file 

 

 
 

39. Check the gtrep_import_log.txt file for errors 
a. Do a Find looking for the word “errors” 

40. Close the gtrep_import_log.txt file 
41. Open the gtrep_import_errors.txt file  

 

 
 

42. Check the gtrep_import_errors.txt file for errors 
a. The file should only have one entry “GTREP IMPORT Standard Error” 

43. Close the gtrep_import_errors.txt file 
44. Go to the Microsoft SQL Server Management Studio 

 

 
 

45. Right click dbo.gtrep_auth_control  
46. From the menu execute Select Top 1000 Rows 
47. Verify that in the Results there are 6 entries 
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Connecting to the Test Data Repository 
 
Now that the “Starter Database” or Test Data Repository has been created, Datamaker needs to 
connect to it.  This is done by defining a Profile using an ODBC Connection to the Test Data Repository.   
  

1. Open Datamaker by clicking the GT Datamaker icon  or go to: 
a. Start > Grid-Tools > GT Datamaker 

 

 
 
Because there is not a Profile to the Test Data Repository the Create connection profile for Test Data 
Repository window (Step 2) will automatically pop up.  However, in case that window gets closed and to 
help familiarize you with this window, there are 3 buttons on this window you should be aware of: 
 

 Connect to Test Data Repository will only work once the Test Data Repository Profile is 
created.  If you click it now you will get an error message. 

 

 Create new Profile (which is covered in Step 2 of this section) pulls up the Create 
connection profile for Test Data Repository window.  Initially because there is no Profile, 
this is why it automatically popping up, forcing you to create a connection. 

 

 Help about GT Datamaker provides version numbers and DLL dates which can be 
emailed to Grid-Tools if needed.  
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Create the Profile for Test Data Repository – MS SQL 
 

 
 

2. Depending upon the type of “Starter Database” that was created, select one of the following: 
a. Oracle 
b. Microsoft SQL Server – Select this Option 
c. Don’t know – Give you a window informing you that you need to find out  

3. Click the blue double arrow icon  to proceed 
 

 
 

4. Because this is the first time, you will get this message, click OK 
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5. The drop-down window will be empty because there are no ODBC Connections, click the icon  
to the right of the drop-down window to Launch the 32-bit ODBC Administrator. 

 

 
 

6. Go to System DSN tab (2nd tab) 
7. Click Add 

 

 
 

8. Slide the bar to the bottom and select SQL Server Native client 10.0 

 SQL Server does not work for this connection 
9. Click Finish 
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10. Enter a Name for this ODBC Connection: Test Repository 
11. (Optional) Enter a Description for this ODBC Connection 
12. Use the drop-down window to select the Server where the Test Data Repository is located 
13. Click Next 

 

 
 

14. Select With SQL Server authentication using a login ID and password entered by the user 
15. Enter the Login ID (sa) 
16. Enter the Password for this Login ID 
17. Verify that Connect to SQL Server to obtain default settings for the additional configuration 

options is checked 
18. Click Next 
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19. Check the box which allows you to Change the default database 
20. Use the drop-down to select the Test Data Repository database, which will be either: 

 gtrep31_starter 

 GTREP 
21. Verify Attach database filename is not checked 
22. Verify Use ANSI quoted identifiers is checked  
23. Verify Use ANSI nulls, padding and warnings is checked 

 

 
 

24. (Optional) Unless required everything on this screen (defaults) should remain the same 
25. Click Finish 

 

 
 

26. Click Test Data Source 
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27. Verify that the TESTS COMPLETED SUCCESSFULLY 
28. Click OK 

 
 

29. Click OK to close the Testing window 
 

 
 

30. Verify that the Test Repository – SQL Server Native Client 10.0 ODBC driver is created 
31. Click OK, this will close the ODBC Data Source Administrator 
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32. A new icon will appear next to the Launch ODBC Administrator icon, this is the Refresh ODBC 

Data Source List icon , Click the Refresh icon. 
 

 
 

33. Click the arrow beside the drop-down window and select the ODBC Source (Test Repository) 
that was just created. 

34. Click the blue double arrow icon  to proceed 
 

 
 

35. Select Use specified login details 
36. Enter the User ID (sa) 
37. Enter the Password for this User ID  
38. Check the box to Store Password 
39. Enter the Default Schema (dbo) 
40. A new green gear icon  has appeared to Test the connection details, click this icon 
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41. Click OK 

 
 

42. Another new green check icon  will appear, Click this icon to Save the Profile 
 

 
 

43. The Profile Name will default to the “User ID – ODBC Connection Name”.  Best Practice would 
be to remove the User ID.  Change the Profile Name to the ODBC Connection Name only: Test 
Repository 

44. Click OK 
 

 
 

45. Click Yes 
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46. Confirm the “Test Repository” Profile is now in Datamaker 
 
Note: Before you can use Datamaker it must be licensed.  To license Datamaker go to the Licensing 

section of this document. 
 
Recommendation:  
 

Now that Datamaker is connected to the Test Data Repository, the next step is to License Grid-
Tools.  Since this usually takes a day or so, we recommend you go to the Licensing section of this 
document and perform the steps in the Generate Candidate Key section immediately.  
 
Once Datamaker is licensed, you may need sample or training databases to connect to for 
testing and to validate that everything is configured correctly.  So while you are waiting for the 
License Key, go to the next section and create the TRAVEL and TRAVEL_E databases. 
 
Then when you receive your License Key go to the Applying the Licensing Key section and 
activate Datamaker using the License key.   
 
Then, because you need Source and Target databases, go ahead and build Profiles and connect 
to the TRAVEL and TRAVEL_E databases. 
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MS SQL Method 2 – Create Travel and Travel_E Databases 
 
If you are attending training or needing additional databases for a demonstration or POC, by following 
the same methodology additional databases can be created.  Located in the Datamaker Installation Kit 
Install_Repository_SQLServer folder is another folder called Install_TRAVEL_SQL_Server.  In this folder 
are the files needed to create the Schema and import the Data for a set of “Travel” databases. 
 
For training purposes you will want to create two (2) databases and run the SQL Query to create 
Schemas in both of these databases.  However, only on one of the databases will you import Data.  This 
way Datamaker can be used to pull, mask, subset, etc. data from the fully loaded database to the empty 
but ready database. 
 
Create the Travel Databases 
 

1. Open the Microsoft SQL Server Management Studio 
2. Right click Databases and select New Database 

 

 
 

3. For the first Database Name enter TRAVEL 
4. For the database file in the PRIMARY Filegroup make the following changes: 

a. Set the Initial Size to 488 MB  
b. Verify that the Autogrowth is set to “By 1 MB, unrestricted growth” 

5. For the second entry (TRAVEL_log) make the following changes: 
a. Set the Initial Size to 1788 MB 
b. Change the Autogrowth to “By 100 percent, unrestricted growth” 

6. Click OK 
7. Right click Databases and select New Database 
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8. For the second Database Name enter TRAVEL_E (“E” for empty, no data will be added to this 
database 

9. For the database file in the PRIMARY Filegroup make the following changes: 
a. Set the Initial Size to 488 MB  
b. Verify that the Autogrowth is set to “By 1 MB, unrestricted growth” 

10. For the second entry (TRAVEL_E_log) make the following changes: 
a. Set the Initial Size to 1788 MB 
b. Change the Autogrowth to “By 100 percent, unrestricted growth” 

11. Click OK 
 

 
 

12. Confirm that TRAVEL and TRAVEL_E databases have been created 
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Add the Schema to the Travel Databases 
 

13. Go to File > Open > File in the Microsoft SQL Server Management Studio 
14. Go to the Datamaker Installation Kit folder Install_TRAVEL_SQL_Server 

 

 
 

15. Select TRAVEL_SCHEMA.sql 
16. Click Open 

 

 
 

17. Verify that the SQL Query loaded 
18. Important – as shown in the picture change the database from master to TRAVEL 
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19. To test the SQL Query, click Parse (blue check above) 
20. Verify that in the Results “Query executed successfully” appears 

 

 
 

21. To execute the SQL Query, click Execute (red exclamation above) 
22. Verify that in the Results “Query executed successfully” appears again 

 

 
 

23. Important – as shown in the picture change the database from TRAVEL to TRAVEL_E 
24. To test the SQL Query, click Parse (blue check above) 
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25. Verify that in the Results “Query executed successfully” appears 
26. To execute the SQL Query, click Execute (red exclamation above) 

 

 
 

27. Verify that in the Results “Query executed successfully” appears again 
28. Close the Microsoft SQL Server Management Studio 

 
Add the Data to the TRAVEL Database Only 
 

48. Open a Command Prompt  
49. Navigate to the Datamaker Installation Kit folder Install_TRAVEL_SQL_Server 

 
In this folder there is a batch file TRAVEL_IMPORT.bat that needs to be executed using specific 
parameters as before, except this time the Target Database will be TRAVEL and we will not do the Data 
Import to the TRAVEL_E database.  Additionally, the files should start with “travel” instead of “gtrep”. 
 
The command that will be entered will look something like this: 
 

TRAVEL_IMPORT username password server TRAVEL > travel_import_log.txt 2> travel_import_errors.txt 

 
Once the command is executed again three (3) files will be created: 
 

 import_report.txt – which needs to be checked for “IMPORT errors” and once it is closed the 
command will finish. 

 travel_import_log.txt – which needs to be checked for “errors” to make sure no commands 
failed 

 travel_import_errors.txt – which needs to be checked for DOS command errors 
 

50. Execute the TRAVEL_IMPORT command using the correct parameters for your environment 
against the TRAVEL database only 
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51. Verify that the Command Prompt stops with “IMPORT Complete” but is still waiting 
52. Verify that the import_report.txt file has opened automatically in Notepad 

 

 
 

53. Check the import_report.txt file for errors 
a. Do a Find looking for the word “errors” 

54. Close the import_report.txt file and verify that the command completes, going back to a prompt 
55. Close the Command Prompt window 
56. Go to the Datamaker Installation Kit folder Install_TRAVEL_SQL_Server 
57. Open the travel_import_log.txt file 

 

 
 

58. Check the travel_import_log.txt file for errors 
a. Do a Find looking for the word “errors” 

59. Close the travel_import_log.txt file 
60. Open the travel_import_errors.txt file  

 

 
 

61. Check the travel_import_errors.txt file for errors 
a. The file should only have one entry “TRAVEL IMPORT Standard Error” 

62. Close the travel_import_errors.txt file 
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Licensing 
 
Before starting this section the Datamaker product must be installed, the “Starter Database” or Test 
Data Repository must be created, and a Datamaker Profile created so that Datamaker can connect to 
the Test Data Repository. 
 
Generating the Candidate Key 
 

1. Open Datamaker 
2. Click the Connect to Test Data Repository icon  to bring up the GT Datamaker Licensing window 

 

 
 

3. Enter the Company Name (CA) 
 
 This top part of this screen is initially used to generate a Candidate Key, which must be sent to Grid-
Tools in order to obtain a License Key.  There are two ways to do this.   
 

 If the machine where Datamaker is installed has an email client, then enter your email address 

and click the mail icon  to mail the Candidate Key to Grid-Tools Support. 
 

 If the machine where Datamaker is installed does not have an email client, click the save  
icon, go to the location where the Candidate key is, and email the file to Grid-Tools Support. 

 
The Candidate Key will be a GTDMLicenceCandidate.txt file.  By default it is placed in a hidden file, so 
you may need to adjust your Windows Explorer setting to allow you to see the folder and file location. 
 

C:\Users\Administrator\AppData\Local\Temp\2 
 

4. Generate a Candidate Key and Email it to Grid-Tools Support 
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Applying the License Key 
 
When you receive your License Key it will be in a TXT file that will have a naming convention similar to 
this: “Company Name”–“Server Name.txt”.  Place this License Key on the machine where Datamaker is 
installed.   
 

5. Open Datamaker 
6. Click the Connect to Test Repository icon to bring up the GT Datamaker Licensing window  

 

 
 

7. Click the Load from File icon  
8. Browse to the location of the License Key and click Open 

 

 
 

9. Verify that the Company Name, License Information, and License Keys all populate with 
information 

10. Click the Activate icon  
 
The Datamaker User Logon screen automatically comes up and you can now log into Datamaker 
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First Time Login Update: 
 
The first time you log into Datamaker it needs to run a script to update the Schema. 
 

 
 

11. Enter Administrator for the User Name 
12. Enter marmite for the Password 

13. Click the green check icon  Connect to User 
 

 
 

14. Click Yes to fix the problem 
 

 
 

15. Enter Administrator for the User Name 
16. Enter marmite for the Password 

17. Click the green check icon  Connect to User 
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18. Click Yes to run the script / update 
 

 
 

19. Verify that the Data Target and Data Source log in GT Datamaker window appears 
 
Recommended:  Close this window and test the login process again. 
 

1. Open Datamaker 
2. Click the Connect to Test Data Repository icon  
3. Enter Administrator for the User Name 
4. Enter marmite for the Password 

5. Click the green check icon  Connect to User 
6. Verify that the Data Target and Data Source log in GT Datamaker window appears and that no 

issues or updates appear 
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Configuration 
 
Datamaker has two Services that need to be configured before they will run: 

 GridToolsRemotePublish 

 GridToolsTDoDService 
 
Also, Database Profiles need to be created so that Datamaker has a Source and Target Databases to 
access when it is operational. 
 
Finally, to simplify the login process a REP.XML file should be created that allow a quicker and easier 
login process. 
 
Grid Tools Remote Publish Service 
 
The only way we were able to get the GridToolsRemotePublish Service to start was to Uncheck Email 
Support Enabled box AND clear the AD Domain field, then Save the configuration. 
 
Here are the screenshots and how we configured the Remote Engine Config Editor.  
 

1. Open the Remote Engine Config Editor 
2. Go to Configure tab > Connection String tab 

 

 
 

 Here is how we configured these settings 
 

3. Click Verify and confirm that the Connection opened successfully 
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4. Go to Configure tab > Job Executors tab settings 
 

 
 

5. Confirm that all items are Enabled 
6. Click Verify and then confirm that Job Executors settings are valid appears 
7. Go to Configure tab > SMTP Settings tab settings 

 

 
 

 Here is how we configured these settings 
 

8. Click Save and confirm the Configuration successfully saved and is Reloaded 
9. Click Verify – Error not sure how to get around this, which is why the initial settings of Uncheck 

the box for Email Support Enabled is done (only combination we found that let service start) 
 

 The Migrate tab is not configured at this time 
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10. Go to the Status tab 
 

 
 

11. Click Restart Service 
12. Verify that The Remote Publish Engine service status is now set to Running 
13. Close the Remote Engine Config Editor 
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Grid Tools TDoD Service 
 
Here are the screenshots and how we configured the TDoD Config Editor.  
 

1. Open the TDoD Config Editor 
2. Go to Configure Service tab > Connection String tab 

 

 
 

3. Configure this tab accordingly 
a. Database Type: (Oracle or SQL Server) 
b. Database Source: Enter DB Server Hostname 
c. User ID: DB User with rights to access database 
d. Password: Password for User ID 
e. Database: (gtrep31_starter or GTREP) 

4. Go to Configure Service tab > Authentication tab 
 

 
 

5. Confirm the Authentication Mode is set to DM 
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6. Go to Configure Service tab > Advanced Settings tab 
 

 
 

7. Enter the Service Base Address: http://(Datamaker server):8090/ 
8. Confirm Disable Plain Text Auth is not checked 
9. Confirm Days to keep web logs is set to 5 
10. Confirm Delete web log every is set to 1 hour 

 

 Migrate tab is not configured at this time 
 

11. Go to Configure Service tab > Connection String tab 
 

 
 

12. Click Verify and confirm the Connection opened successfully 
13. Click Save and confirm the Information successfully saved and reloaded 
14. Click Restart Service and confirm the TDoD Service status is now set to Running 
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15. Go to Configure Portal tab > Settings 
 

 
 

16. Configure this tab accordingly: 
a. Service URL: http://(Datamaker Server):8090/GTService 
b. ALM Service URL: (blank) 
c. IVS URL: (blank) 
d. Temp Directory Path: (blank) 
e. Max Items in Web Controls: 100 

17. Click Verify and confirm the TDOD Service is valid 
18. Click Save and confirm the Information successfully saved and reloaded 

 

 Migrate tab is not configured at this time 
 

19. Close the TDoD Config Editor 
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Database Profiles 
 
Once you have Datamaker licensed, it needs a Source (database) to pull from and a Target (database) to 
put data in.  As we did with the Test Data Repository, these Source and Target (databases) need Profiles 
built so that Datamaker can connect. 
 
Because we are using and have built the TRAVEL and TRAVEL_E Databases for Training, we will use them 
as our Source and Target in this document as examples of how to set each up.  
 

1. Open Datamaker 
2. Click the Connect to Test Data Repository icon 
3. Log in to Datamaker  

 

 
 
The following is a review and update of the icons which are used to perform various functions: 

 Connect to Test Data Repository         

 Create new Profile           

 Connect Data Target          

 Connect Data Source          

 Help about GT Datamaker          
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Connecting to a Data Source – TRAVEL 
 

 
 

4. Click the Create new Profile icon  
 

 
 

5. Select Microsoft SQL Server 
6. Click the blue double arrow icon  to proceed 
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7. Since there is not an ODBC Connection to the TRAVEL Database, one needs to be created, click 
the icon  to the right of the drop-down window to Launch the 32-bit ODBC Administrator. 

 

 
 

8. Click the System DSN (2nd) tab 
9. Click the Add button to add a new System Data Source 

 

 
 

10. Slide the bar to the bottom and select SQL Server Native Client 10.0 
11. Click Finish 

 

 
 

12. Enter a Name for this ODBC Connection: Travel Production 
13. (Optional) Enter a Description 
14. From the drop-down window select the Server where the TRAVEL Database is located 
15. Click Next 
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16. Select With SQL Server authentication using a login ID and password entered by user 
17. Enter the Login ID (sa) 
18. Enter the Password for the Login ID 
19. Click Next 

 

 
 

20. Check the Change the default database to box 
21. From the drop-down window select the TRAVEL database 
22. Click Next 

 

 
 

23. Click Finish 
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24. Click Test Data Source 
 

 
 

25. Verify the TESTS COMPLETED SUCCESSFULLY 
26. Click OK 

 

 
 

27. Click OK 
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28. Verify that the Travel Production System Data Source entry is now available 
29. Click OK 

 

 
 

30. Click the Refresh icon  
31. From the drop-down window select Travel Production for the ODBC Source 
32. Click the blue double arrow icon  to proceed 

 

 
 

33. Select Use specified login details 
34. Enter the User ID (sa) 
35. Enter the Password for the User ID 
36. Check the Store Password box  
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37. Enter the Default Schema (dbo) 

38. Click the Test the connection detail icon  
 

 
 

39. Click OK 
 

 
 

40. Click the Save the Profile icon   
 

 
 

41. Change the name (removing the “sa”) to Travel Production 
42. Click OK 

 

 
 

43. Click Data Source because this is the TRAVEL Database 
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44. Verify that the Travel Production Profile has been added and the Data Source checkbox is 
checked 

 
 
 
 
 
 
 
 
 



105 

Connecting to a Data Target – TRAVEL_E 
 

 
 

1. Click the Create new Profile icon  
 

 
 

2. Select Microsoft SQL Server 
3. Click the blue double arrow icon  to proceed 
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4. Click the Launch the 32-bit ODBC Administrator icon  
 

 
 

5. Click the System DSN (2nd) tab 
6. Click the Add button to add a new System Data Source 

 

 
 

7. Slide the bar to the bottom and select SQL Server Native Client 10.0 
8. Click Finish 

 

 
 

9. Enter a Name for this ODBC Connection: Travel Test 
10. (Optional) Enter a Description 
11. From the drop-down window select the Server where the TRAVEL_E Database is located 
12. Click Next 
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13. Select With SQL Server authentication using a login ID and password entered by user 
14. Enter the Login ID (sa) 
15. Enter the Password for the Login ID 
16. Click Next 

 

 
 

17. Check the Change the default database to box 
18. From the drop-down window select the TRAVEL_E database 
19. Click Next 

 

 
 

20. Click Finish 
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21. Click Test Data Source 
 

 
 

22. Verify the TESTS COMPLETED SUCCESSFULLY 
23. Click OK 

 

 
 

24. Click OK 
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25. Verify that the Travel Test System Data Source entry is now available 
26. Click OK 

 

 
 

27. Click the Refresh icon  
28. From the drop-down window select Travel Test for the ODBC Source 
29. Click the blue double arrow icon  to proceed 

 

 
 

30. Select Use specified login details 
31. Enter the User ID (sa) 
32. Enter the Password for the User ID 
33. Check the Store Password box  
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34. Enter the Default Schema (dbo) 

35. Click the Test the connection detail icon  
 

 
 

36. Click OK 
 

 
 

37. Click the Save the Profile icon   
 

 
 

38. Change the name (removing the “sa”) to Travel Test 
39. Click OK 

 

 
 

40. Click Data Target because this is the TRAVEL_E Database 
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41. Verify that the Travel Test Profile has been added and the Data Target checkbox is checked 
 

Recommendation: Repeat Travel and Travel_E processes for Orders and Orders_E 
 

42. Click the Connect to databases and startup icon  



112 

How to Create the REP.XML file 
 

1. Open Datamaker 
 

 
 

2. Click the Connect to Test Data Repository icon  
 

 
 

3. Log in to Datamaker  
 

 
 

4. Verify a Data Source and Target are selected 

5. Click the Connect to databases and startup icon  
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6. Go to Security and select from the drop-down menu Users and Groups 

7. In the upper corner of the Maintain Security window, click the XML icon  
 

 
 

8. Enter the Administrator User Name for your system: (Administrator) 
9. Enter the Administrator Password: (marmite) 

 

 
 

10. Read the message and confirm the location where the rep.xml file was created 
a. C:\Users\Administrator\AppData\Roaming\Grid-Tools\rep.xml 
b. This is a hidden folder, adjust the setting on the computer to see this folder 

11. Copy the file to the C:\Program Files (x86)\Grid-Tools\GTDatamaker folder 
12. Click OK 
13. Close Datamaker to validate that the REP.XML file works 
14. Open Datamaker 

 

 
 

15. Verify the Test Data Repository window no longer appears 
16. Log in to Datamaker  
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17. Verify the Data Target and Data Source window comes up 

18. Click the Connect to databases and startup icon  
 

 
 

19. Confirm Datamaker come up and is fully operational 
 
 
 
 
 
 
 
 

 


